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1. ZAVRŠNI RAD  

  

Završni rad je učenikova samostalna stručna obrada izabrane teme. Izradbom i 

obranom završnog rada učenik:  

• pokazuje stupanj usvojenosti teorijskog i praktičnog znanja i sposobnost 

služenja stručnom literaturom i elektroničkim izvorima podataka,  

• dokazuje stupanj stečenih kompetencija i ishoda obrazovanja u obrazovnom 

profilu,  

• pokazuje se kompetentnost samostalnog istraživanja i stručne obrade izabrane 

teme na sustavan, smislen i gramatički i pravopisno ispravan način.   

Obranom završnog rada u obliku prezentacije pokazuje se učenikova sposobnost 

samostalnog izlaganja, objašnjavanja i prezentiranja rezultata istraživanja u pisanom 

radu.  

  

Učenik izabire temu završnog rada u dogovoru s predmetnim nastavnicima struke, a 

poštujući rokove iz Pravilnika o izradbi i obrani završnog rada.1  

  

Nakon izbora teme završnog rada učenik  predlaže nacrt ili strukturu završnog rada 

mentoru na redovitim konzultacijama. Ovdje je važno da učenik navede popis 

literature i druge izvore podataka koje namjerava koristiti pri izradi završnog rada. 

Nastavnik zajedno s učenikom definira precizan sadržaj i strukturu završnog rada. 

Tijekom izrade u vrijeme dogovorenih konzultacija nastavnik stoji na raspolaganju za 

sve eventualne nejasnoće, sugestije oko pisanja rada i savjete oko dodatnih izvora 

literature. Nakon što izabere temu završnog rada učenik  prikuplja literaturu, udžbenike, 

članke iz časopisa, informacije s interneta ili baza podataka koji obrađuju izabranu 

tematiku. Proučavanje stručne literature je nužan preduvjet daljnjeg samostalnog rada.  

  

Učenik izrađuje rad samostalno s pravom i obvezom redovitih konzultacija s 

mentorom. Mentor prati rad učenika i pomaže mu savjetima, a može zahtijevati 

doradu, izmjenu ili dopunu završnog rada. Učenik  je dužan postupiti prema uputama i 

primjedbama mentora.  

  

Završni rad treba spiralno uvezati u dva primjerka (jedan se predaje mentoru, drugi se 

urudžbira).  

  

Završni rad sastoji se od sljedećih dijelova:  

1. Naslovna stranica  

2. Sadržaj  

3. Sažetak  

4. Uvodni dio  

 
1 Broj tema treba biti 50% veći od broja učenika (npr. ako imamo ukupno 30 maturanata u cijeloj školi, 

treba ponuditi 45 tema).  
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5. Glavni dio – razrada teme  

6. Zaključak  

7. Literatura  

8. Popis slika/grafičkih prikaza/tablica  

9. Prilozi  

10. Posljednja  stranica rada (za upisivanje ocjena)  

  

2. DIJELOVI ZAVRŠNOG RADA  

  

2.1. Naslovna stranica  

Autor naslovnom stranicom uspostavlja prvi kontakt s čitateljem rada i ostavlja prvi 

dojam o završnom radu. Naslovna stranica treba sadržavati osnovne podatke: o školi, 

smjeru, učeniku, mentoru, nastavnom predmetu, temi završnog rada (naziv teme), 

školskoj godini, te biti oblikovana prema pravilima i uputama struke. Naslovna stranica 

se ne označava rednim brojem, a ubacivanje slikovnih prikaza se ne dozvoljava. 

Primjer oblikovanja naslovne stranice završnog rada nalazi se u prilogu uputa 

(Prilog_1., str.12.).   

  

2.2. Sadržaj  

Sadržaj predstavlja tematski prikaz rada i daje uvid u stranice rada na kojima se nalaze 

naslovi cjelina, poglavlja, odjeljaka. Sadržaj se stavlja odmah iza naslovne stranice 

rada te ga je potrebno oblikovati prema pravilima i uputama. Primjer oblikovanja 

stranice sadržaja nalazi se u prilogu uputa (Prilog_2., str.13.), a objašnjenje oblikovanja 

i umetanja sadržaja dano je u nastavku uputa (3. Oblikovanje završnog rada).  

  

2.3. Sažetak  

Sažetak je, kako mu i ime govori, sažeta verzija cjelokupnog rada. Poželjan opseg 

sažetka je jedna do jedna i pol stranica teksta. Sažetak se može početi pisati tek kada 

je cjelokupan završni rad napisan, točnije: dio rada od uvoda do zaključka. Piše se bez 

podnaslova, poput eseja (ne numerira se kao cjelina, već se samo stavlja naznaka, 

naslov da je riječ o sažetku), a u njemu se ukratko:  

▪ opisuju svrha i ciljevi rada,  

▪ izlažu teorijska polazišta, ▪ povezuju s praktičnim 

dijelom, ▪ navode zaključci.  

Stranica sažetka se numerira (primjerice: rimskim brojevima).  

  

2.4. Uvod   

Uvod sadrži osnovne naznake problema koji se razmatra: imenuje se problem i razlog 

izbora za predmet proučavanja, način obrade problema i strukturu rada. Uvod se 

numerira arapskim brojem 1 (predstavlja prvu cjelinu rada), kao i broj stranice rada koji 
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se označava arapskim brojem 1. Objašnjenje oblikovanja i umetanja brojeva stranica 

dano je u nastavku uputa (3. Oblikovanje završnog rada).  

  

2.5. Glavni dio  

Glavni dio ili razrada teme završnog rada, ukoliko to tema dopušta, sastoji se od dva 

temeljna dijela. Prvi dio odnosi se na teorijski dio obrade teme u kojem se navode 

teorijski doprinosi različitih autora i objašnjenje iste, dok je drugi dio praktični dio u 

kojem se prikazuje konkretan primjer problema ili slučaj iz prakse. Cjelokupan sadržaj 

teksta u radu treba biti smisleno raspoređen. Cjeline rada se označavaju arapskim 

brojevima, kao i brojevi stranice završnog rada.  

  

2.6. Zaključak  

Obrada teme završnog rada završava cjelinom zaključak u kojemu je potrebno ukratko 

prikazati rezultate i spoznaje do kojih se došlo prilikom obrade teme završnog rada. 

Ujedno, u zaključku je poželjno iznijeti stav o istraženom problemu, prikazati 

eventualnu nepodudarnosti teorije i prakse, te istaknuti vlastita mišljenja i prijedloge. 

Zaključak mora započeti na zasebnoj stranici, numerira se kao cjelina i brojevi stranice 

se nastavljaju u odnosu na glavni dio.  

  

2.7. Literatura  

Popis literature koja se koristila prilikom obrade teme završnog rada slijedi nakon 

zaključka, a prije popisa slikovnih, grafičkih ili tabelarnih prikaza te eventualnih priloga 

ili dodataka. Naslov Literatura numerira se i piše velikim slovima na vrhu stranice. 

Primjer oblikovanja literature završnog rada nalazi se u prilogu uputa (Prilog_3., 

str.15.). Izvori se nižu abecednim redom prema prezimenu autora, a ukoliko ne postoji 

autor ili urednik izvora, zapisuju se prema prvoj riječi iz naslova. Izvore numeriramo sa 

arapskim brojevima,  navodeći najprije prezime autora koje se odvaja zarezom od 

inicijala imena. Zatim se piše naslov knjige, ime izdavačke kuće, sjedište izdavačke 

kuće ili mjesto gdje je knjiga izdana te godina kada je izdana. Članci korišteni u radu 

navode se na slijedeći način: najprije se zapisuje naziv autora, zatim naslov članka te 

časopis u kojem je članak objavljen, broj časopisa, godina izdanja navedenoga broja, 

te stranice na kojima je članak tiskan. Objašnjenje oblikovanja i označavanja literature 

dano je u nastavku uputa (3. Oblikovanje završnog rada).  

  

2.8. Slikovni, grafički i tabelarni prikazi  

Nakon popisa literature, na zasebnoj stranici navode se slikovni, grafički ili tabelarni 

prikazi koji se nalaze u cjelinama završnog rada. Naslov Slikovni prikaz, Grafički prikaz 

ili Tabelarni prikaz numerira se i piše velikim slovima na vrhu stranice. Ukoliko se u 

radu nalazi manji broj i slikovnih i grafičkih i tabelarnih prikaza, možete ih staviti na 

jednu stranicu, tako da odvojite dvostrukim proredom naslove. Popis navedenih 

prikaza numerira se arapskim brojevima, stavlja se oznaka slike, tablice, grafičkog 

prikaza, broj slike, tablice ili grafičkog prikaza, naziv prethodno navedenog i broj 

stranice na kojoj se nalazi. Ujedno, popis slikovnih, grafičkih i tabelarnih prikaza 
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potrebno je navesti i u sadržaju rada. Primjer oblikovanja popisa slikovnih, grafičkih i 

tabelarnih prikaza završnog rada nalazi se u prilogu uputa (Prilog_4., str.16.). 

Objašnjenje oblikovanja i označavanja dano je u nastavku uputa (3. Oblikovanje 

završnog rada).  

  

2.9. Prilozi  

Prilozi (dokumenti i slično ) koje ste koristili prilikom obrade teme završnog rada, a koji 

dopunjuju završni rad, stavljaju se na kraj rada. Numeriraju se na vrhu stranice (Prilog 

br. 1, Prilog br.2 ...), svaki prilog ima svoju stranicu i kao takvi se navode u i sadržaju 

rada.   

  

 2.10.  Posljednja stranica rada  

Na posljednjoj  stranici rada ostavlja se prostor u koji će se upisati datum predaje rada, 

ocjena izradbe rada, potpis mentora kao dokaz da je mentor prihvatio rad, datum 

obrane rada i ocjena obrane rada, te završna ocjena koja proizlazi iz aritmetičke 

sredine ocjena izradbe i obrane rada. Moguće je upisati i komentar mentora ili komisije 

za obranu. Primjer oblikovanja posljednje stranice završnog rada nalazi se u prilogu 

uputa (Prilog_5., str.17.).  

  

 2.11.  Konzultacijski list  

Mentor za svakog učenika ispunjava konzultacijski list na kojem evidentira kada je i 

koliko puta učenik bio na konzultacijama. Konzultacijski list ostaje kod mentora i nije 

dio završnog rada. Primjer oblikovanja konzultacijskog lista nalazi se u prilogu uputa 

(Prilog_6., str. 18.).  

  

3. OBLIKOVANJE ZAVRŠNOG RADA  

  

3.1. Podsjetnik   

Prije pisanja završnog rada treba se prisjetiti:  

  

✓ riječi se odvajaju samo jednim razmakom,  

✓ interpunkcijski znakovi (. , ? ! : ; ) pišu se zajedno s riječju iza koje slijede, a 

nakon navedenog ostavlja se obvezno jedan razmak,  

✓ navodnici i zagrade pišu se zajedno s riječju ispred i iza koje se nalaze,  

✓ crtica se piše zajedno s riječima između kojih stoji ako se radi o složenici   

(npr. matematičko-informatički), a odvojeno ako se koristi u neku drugu svrhu,  

✓ rečenicu nikada ne valja započinjati brojkom,  

✓ tekst treba pisati u odlomcima (odlomak je dio teksta koji zaključujemo tipkom 

<Enter> ),  

✓ početak odlomka mora biti uvučen → tipka <Tab>,  
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✓ ukoliko navodite ili numerirate dijelove teksta u razradi sadržaja iza navedeno 

stavljate zarez, a iza posljednjeg navoda točku (kao što je označe i navedeni 

navod) .  

  

  

3.2.  Razrada sadržaja završnog rada  

  

3.2.1. Veličina slova i vrsta pisma  

Standardna veličina slova za cijeli tekst u razradi sadržaja je 12, dok su naslovi cjelina 

14. Izuzetak je naslovnica gdje je dio pisan fontom 14, a dio fontom 12 (vidi Prilog_1).  

Vrsta pisma (font) treba biti  Times New Roman ili Arial, a odabrani font mora se 

primjenjivati na cijeli tekst završnog rada. Stil fonta (Bold, Italic, Underline, promjena 

boje slova), odnosno način isticanja dijelova teksta se ne primjenjuje na cijeli tekst, već 

samo na pojedine riječi ili dijelove rečenica koje se žele posebno istaknuti. Navedeno, 

nije poželjno koristiti prečesto, budući da će rad izgledati neuredno, a isto tako 

potrebno je voditi računa da je preporuka koristiti najviše tri različita oblika isticanja 

dijelova teksta jer će u protivnome rad izgledati kao slikovni prikaz. Veličina slova i 

način isticanja mijenjaju se na slijedeći način:  

a) Označi/odaberi sve (Edit → Select All),  

b) veličina slova je 12 (Format → Font → Size: 12)  

c) font (Format → Font → Font: Arial/TNR)  

  

3.2.2. Obostrano poravnanje sadržaja  

Sadržaj rada potrebno je (obavezno!) poravnati obostrano (naslove ćemo naknadno 

oblikovati), ostavljajući prored između redova 1,5 (standardni prored za završni rad):  

A) označi sve (Edit → Select All)  

B) poravnanje je obostrano (Format →  

Paragraph → Alignment: justified)  

  

C) prored je 1.5 (Format → 

Paragraph → Line spacing: 1.5 lines)  
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3.2.3. Postavljanje standardne margine 

stranica Standardne margine stranica 

(gore, dolje, lijevo i desno) su 2,54 cm (1 

inch). Potrebno je postaviti i uveznu 

marginu slijeva (oko 1 cm) koja služi s 

uvlačenje odlomka.   

  

File → Page Setup... → kartica Margins 

→ margine (Top, Bottom, Left, Right) 

staviti na 2,54 cm, a uveznu (Gutter) na 

1 cm  

  

   … ili …  

 kliknuti na ravnalo na 1,5, pojavi se mali crni 

znak u obliku slova L i svaki puta kada se klikne 

na TAB automatski uvuče sadržaj na 

postavljeno (ukoliko ga želite ukloniti, kliknuti na 

navedeno, držati i maknuti s ravnala te pustiti).   

  

  

  

  

3.2.4. Slikovni, grafički i tabelarni prikaz  

Slike, crteži, tablice i grafikoni ubacuju se između teksta te nadopunjuju i potvrđuju 

navedenu razradu sadržaja. Po jedan red razmaka stavlja se prije i poslije prikaza. 

Svaka slika, crtež, tablica ili grafički prikaz ima slijedeće oznake:  

  

1. Naznaku o čemu je riječ:  slika, grafički prikaz ili tablica,  

2. Redni broj,  

3. Naziv,  

4. Prikaz – slika, tablica, graf,  

5. Izvor,  

  

a navedeno se piše uskoredno, jedno ispod drugog, bez rednog razmaka (prored je 

1,0).   

  

  

Navedeno je u razradi sadržaja teme moguće oblikovati na nekoliko načina:  
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1. centriranjem na sredini stranice, ili  

2. od 0. TAB-a (bez uvlačenja).  

  

Ujedno, oznake je moguće pisati na slijedeći način:  

  

  1. oznaka, redni broj i naslov iznad prikaza, a izvor navedenog ispod 

prikaza, ili   2. oznaka, redni broj i naslov ispod prikaza, a izvor navedenog se 

stavlja kao fusnota.  

  

Primjer tabličnog prikaza, pisanje od 0.TAB-a:  
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Primjer slikovnog prikaza, centriranjem na sredini stranice:  

 
  

Naslovna stranica, sadržaj i sažetak ne smije imati oznaku arapskog broja stranice. 

Najbolji način za to je umetanje prekida stranice. Primjer:  

  

3.2.5.   Umetanje brojeva stranica   

Stranice završnog rada trebaju biti  

pravilno označene.   Broj stranice možete  

umetnuti ili u  zaglavlje (header) ili  

podn ). ožje  ( footer   Također,  možete  

odabrati   izgleda broja stranice , boju, font .    

a)   Insert  →   Page Numbers   

b)   možemo odabrati hoće li brojevi  

stranica biti gore ili dolje (Position)   

c)   lijevo, desno ili u sredini (Alignment)   

d)   naslovna stranica bez oznake broja  

stranice  ( Show  prazno  ostaviti  

number on first page)   
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3.2.6. Zaglavlje i podnožje  

U zaglavlje ili podnožje može se smjestiti tekst koji će biti vidljiv na svim stranicama 

rada. Primjerice, u zaglavlje možete napisati naziv autora i naslov rada što je zgodno 

podvući da se odvoji od glavnog teksta.  

a) View → Header and Footer,  

b) otvorit će se okviri za zaglavlje i podnožje (ostatak teksta je sive boje),  

c) upišemo željeni tekst, formatiramo ga – veličina slova, poravnanje, crta 

ispod,...,  

d) naredbom Close zatvaramo pogled zaglavlja i podnožja i vraćamo se u 

tekst rada (sad je zaglavlje i podnožje sive boje),  

e) Print Preview (pod File) možemo pogledati jesmo li zadovoljni izgledom 

rada.  

  

Prekid stranice  –   prijelaz na slijedeću stranicu, stupac ili  

pre lamanje teksta.   

  

Odjeljak = sekcija   

  

Prijelom odjeljka  –   stvaranje zasebnih cjelina u  

tekstualnom dokumentu.   

  

Prijelom stranice  –   postavljanje kursora na početak  

slijedeće stranice.   

  

Prazna stranica  –   umetanje prazne stranice u tekstualni  

dokument.   

Ukolik o koristimo prijelom stranice tada je  

moguće promijeniti zaglavlje i podnožje, a da  

ne nadovezuje  prethodno  se  ono  na  

napisano u zaglavlju i podnožju, pa i  

promijeniti brojeve stranica (numeriranje).   

  

Kada otvorite zaglavlje ili podnožje i  ne želite   

da se  ono nadovezuje na prethodnu sekciju  

kliknuti na poveži s prethodnim, tada možete  

promijeniti zaglavlje ili podnožje bez da se  

prethodno promijeni, pa i umetnuti brojeve  

stranica, a da se one ne pojavljuju na  

naslovnoj stranici, sadržaju ili sažetku.   
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3.2.7. Označavanje dijelova (cjelina) završnog rada  

Najpreglednije način označavanja dijelova rada predstavlja decimalni sustav brojeva. 

Svaka se glava (cjelina) označava arapskim brojem (1., 2., 3.,...). Prva znamenka 

svakoga poglavlja podudara se s brojem glave kojoj poglavlje pripada, a druga 

znamenka označava redni broj navedenoga poglavlja (1.1., 1.2., 1.3.,...). Isti postupak 

slijedi za označavanje odjeljaka (1.4.1., 1.4.2.,...) i točaka. (Pogledati kako je rad 

označen u sadržaju, Prilog br. 2).  

Najprije se treba "prošetati" tekstom i ispred naslova dodati gore navedene oznake. 

Pritom se i prije i poslije naslova stavlja po jedan red razmaka. Svaka glava (cjelina) 

treba početi na novoj stranici (Insert → Break → Page Break). Zatim se naslovima 

dodjeljuju stilovi:  

• Naslove cjelina formatira se u Naslov1 (Heading1),   

• nazive poglavlja u Naslov2 (Heading2),  

• nazive odjeljaka u Naslov3 (Heading3), pritome se svakom stilu 

(Heading1, Heading2, Heading3) može dodati još neki od formata za oblikovanje 

teksta kao npr: Bold, Italic, Underline. Veličina slova za Heading1 mora biti veća od 

Heading2, a ona veća od Heading3 koja je veća ili jednaka normalnom tekstu ( font 

12). Označi se prvi naslov cjeline, na njega se primijeni Heading1 (Format → Style 

→ Heading1...), po želji se doda još neki od formata za oblikovanje teksta (boja, 

veličina slova). Nakon toga se u popisu stilova javlja Heading1+... (ono što ste 

dodali). Zatim se redom označavaju i naslovi preostalih cjelina i na njih se primijeni 

isti taj stil Heading1+... Zgodno je za to koristiti prenositelja oblikovana (Format 

painter). Isti postupak se ponavlja za poglavlja (Heading2+...), odjeljke 

(Heading3+...),...  

  

3.2.8. Citiranje i bilješke  

Prilikom citiranja autora u razradi sadržaja, citat je potrebno staviti u navodnike, 

primijeniti kurziv (stil Italic) te navesti autora kojeg smo citirali. Za to se mogu koristiti 

fusnote u koje se mogu stavljati i definicije, napomene i slično. Primjerice: 

"Informacijska znanost je znanost koja se bavi informacijama u najširem smislu." 1 . 

Fusnote umećemo na slijedeći način:  

a) Insert → Reference → Fusnote → OK, u tekstu se pojavio se redni broj 

fusnote (1),  

b) na toj stranici ispod teksta iza znaka 1 potrebno je dopisati komentar 

na citat ovako: 1 Grundler, D., Blagojević, L. Informatika 1, Zagreb: 

Školska knjiga, 2007., str. 14.  

Fusnote za materijal preuzet s Internet stranice (članci) ili izvor slikovnog prikaza - 

potrebno je staviti dio linka i datum.  
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3.2.9. Navođenje literature  

Navođenja literature ovisi o tome je li riječ o stručnim knjigama, stručnim člancima ili 

Internet stranicama koje se koriste prilikom razrade sadržaja završnog rada. 

Udžbenici srednjoškolskog obrazovnog sustava ne mogu biti izvori literature!   

Primjer navođenja literature:  

Stručne knjige:  

1.  

2.  

Kuvačić, N: Poduzetnički projekt – Kako sačiniti biznis-plan?-

Teorijski prikaz, Veleučilište u Splitu, Split, 2001.  

Marušić, M: Plan marketinga za uspješno tržišno poslovanje, 

Adeco, Zagreb, 1998.  

Stručni 

članci:  

1.  

2.  

Solomon, G., King, S: Issues in growing a family business, 

Journal of Small Business Management, 2001. vol. 39(1), pp. 

3-13.  

Jelavić, F: Aktivnosti učenika kao temeljna odrednica 

nastave, Pedagoški rad, br. I, 1988., str. 44 – 51.  

Internetske 

stranice:  

1.  

2.  

web stranice Hrvatske gospodarske komore www.hgk.hr 

(10. 01. 2010) www.Home-Small-Business.com (05.12. 

2009)  

Osim cijelog imena Internet stranice u zagradi je potrebno navesti i datum posjete 

stranici s koje smo preuzeli podatke!   

U izradi svoga završnog rada koristit ćete Internet pa je stoga važno naglasiti da se 

metoda copy-paste s interneta u Word ne smatra izradom završnog rada. Podaci se 

mogu preuzeti s interneta, ali to na smije biti copy-paste čitavih stranica.  

Podsjetnik: Izvori se nižu abecednim redom prema prezimenu autora, a ukoliko ne 

postoji autor ili urednik izvora, zapisuju se prema prvoj riječi iz naslova. Izvore 

numeriramo sa arapskim brojevima,  navodeći najprije prezime autora koje se odvaja 

zarezom od inicijala imena. Zatim se piše naslov knjige, ime izdavačke kuće, sjedište 

izdavačke kuće ili mjesto gdje je knjiga izdana te godina kada je izdana. Članci korišteni 

u radu navode se na slijedeći način: najprije se zapisuje naziv autora, zatim naslov 

članka te časopis u kojem je članak objavljen, broj časopisa, godina izdanja 

navedenoga broja, te stranice na kojima je članak tiskan.  

  

  

Broj stranica završnog rada: - za prodavače: od 7 do 10 stranica, a za 

ekonomiste i komercijaliste od 10 do 15 stranica2.   

  

Naslovna stranica i prilozi se ne računaju!   

             

 
2 Jedna stranica teksta treba sadržavati 1800 znakova po stranici,tj. jednu karticu teksta. Kako 

izračunati karticu teksta? Tools (alati)--Word count (brojanje riječi)—Caracters with blank spaces 

(znakova s prazninama). Dobiveni broj podijelite s 1800 i dobit će te točan broj napisanih kartica (koji 

treba biti jednak zadanom broju stranica).   

http://www.hgk.hr/
http://www.hgk.hr/
http://www.hgk.hr/
http://www.home-small-business.com/
http://www.home-small-business.com/
http://www.home-small-business.com/
http://www.home-small-business.com/
http://www.home-small-business.com/
http://www.home-small-business.com/
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Dva primjerka spiralno uvezanog rada (s potpisom mentora  na posljednjoj 

stranici kojim se potvrđuje da je mentor prihvatio rad ) treba  predati u tajništvo 

škole na ovjeru i urudžbiranje do dogovorenog roka.   

  

U dogovoru s mentorom (do navedenog datuma) predajete rad na prvo čitanje!  

  

Do datuma koji vam kaže mentor rad se predaje u spiralnom uvezu u dva 

primjerka.  

  

Cilj je izradbe i obrane završnoga rada provjera, vrjednovanje i ocjenjivanje postignutih 

strukovnih, odnosno umjetničkih kompetencija učenika, stečenih obrazovanjem prema 

propisanim stručnoteorijskim i praktičnim dijelovima nastavnih planova i programa, 

čime stječu završnost u upisanome obrazovnom programu te uvjete za uključivanje na 

tržište rada.   

  

Mentor nije dužan prihvatiti rad ukoliko on ne zadovoljava pravila oblikovanja i 

preporuke, bilo da je riječ o oblikovanju sadržaja ili razradi sadržaja teme!  

  

  

  

  

  

  

  

  

4. OBRANA ZAVRŠNOG RADA  

  

Obrana završnog rada:  

  

➢ završni rad brani se pred tročlanim povjerenstvom koji čine razrednik, mentor i 

profesor struke,  

➢ obrana rada traje najduže 30 minuta,  

➢ od učenika se očekuje da samostalno predstavi osnovne teze svoga rada, da 

pokaže samostalno vladanje obrađenom temom i odgovori na pitanja ispitivača,  

➢ samostalno predstavljanje teme rada obavlja se uz pomoć PowerPoint 

prezentacije koja mora imati 10 slajdova (ukoliko to mentor traži),  

➢ Ukoliko učenici imaju noviju verziju Microsoft Officea neka prezentaciju pri 

snimanju pretvore u verziju 97-2003. → Save as–Save asType: PowerPoint 97-

2003.,  

➢ nakon prezentacije  učenik odgovara na pitanja povjerenstva,  

➢ učeniku se ocjena ne priopćava  odmah, nego tek kada svi učenici završe s 

obranom radnji.  
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Prilog br .1: Naslovna stranica  završnog rada                                               

  

Srednja škola Koprivnica Trg 

slobode 7  

48000 Koprivnica  

*  
*  
*  
*  
*  
*  
*  
*  
*  
*  
*  

Završni rad iz predmeta:  

*  

Poduzetništvo  

*  
*  
*  
*  
*  

*  

Tema:  

*  

Obiteljsko poduzeće kao oblik poduzetničkog pothvata  

*  

*  

*  

*  

*  

*  

*  

*  

Zaglavlje;  

Centrirano  

Font 14, 

Bold  

 

 

Centrirano, Font 

12  
 

 

Centrirano, Font 

14, Bold  
 

Centrirano, Font 

12  

Centrirano, Font 14, 

Bold  

 

Font 12  

Uvučeno 

na  

1.TAB  
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*  

*  
   Mentor: Učenik: 

 
Font 12 

 

  Ana Anić, prof. Marko Marić, 4.a 

 
 
 

 Smjer: Komercijalist  
Poravnato 

 

* ljevostrano  

*  

*  

Koprivnica, ljetni rok 

šk.god. 2019./2020. 

  
  

  
Prilog br. 2: Sadržaj  

  

                                                       S A D R Ž A J:  

  

SAŽETAK............................................................................................................... I   

1. UVOD ............................................................................................................... 3  

  

2. RAČUNOVODSTVO TRGOVINSKIH PODUZEĆA .......................................... 4  

  

2.1. Pojam računovodstva 

.................................................................................... 4  

2.2. Povijesni razvoj računovodstva 

..................................................................... 4  

2.3. Načela računovodstva 

................................................................................... 5 2.4. 

Računovodstveni proces 

............................................................................... 6  

2.5. Knjigovodstvene isprave u računovodstvu trgovačke robe ............................ 6  

  

3. UPRAVLJANJE U RAČUNOVODSTVU ........................................................... 7  

  

3.1. Struktura računovodstva 

................................................................................ 7  

3.2. Financijsko upravljanje 

.................................................................................. 7  

3.3. Upravljačko računovodstvo 

............................................................................ 8  

3.4. Informacije potrebne za donošenje upravljačkih odluka 

................................ 8  

Poravnato 

ljevostrano  

 

 
 

Podnožje, Centrirano, 

Font 12  
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4. PLANIRANJE U RAČUNOVODSTVU .............................................................. 9  

  

4.1. Strateško planiranje i postojeći program 

........................................................ 9  

4.2. Formalni sustav strateškog planiranja 

........................................................... 9  

4.3. Računovodstveno planiranje ....................................................................... 

10       4.3.1. Svrha računovodstvenog planiranja 

.................................................... 10  

      4.3.2. Zadaci računovodstvenog planiranja .................................................. 10  

  

5. RAČUNOVODSTVENO PLANIRANJE U TRGOVINI .... .................................11  

  

5.1. Pojam računovodstvenog plana .................................................................. 

11 5.2. Plan prodaje 

................................................................................................ 11       5.2.1. 

Pogreške u prognozi prodaje .............................................................. 11  

      5.2.2. Tehnike predviđanja prodaje .............................................................. 12       

5.2.3. Podloga za prognozu i izrada plana prodaje ....................................... 13  

5.3. Plan nabave ................................................................................................. 13  

5.3.1. Pretpostavke za izradu plana nabave ................................................. 

14  

5.3.2. Pogreške u planiranju zaliha ............................................................... 

14  

5.4. Plan troškova marketinga i uprave .............................................................. 

15  

5.5. Plan novca ................................................................................................... 

15  

5.6. Upravljanje novcem ..................................................................................... 

15  

5.7. Planski financijski izvještaji .......................................................................... 

16 5.8. Izrada računovodstvenog plana 

................................................................... 16  

5.8.1. Vremenski vijek računovodstvenog plana ........................................... 

16  

5.8.2. Komisija za planiranje ......................................................................... 

17 5.9. Uloga računovodstva u planiranju 

............................................................... 18  

5.10. Ljudski utjecaj u računovodstvenom planiranju ......................................... 

18  

5.11. Ograničenja planova .................................................................................. 

19  

  

6. PRIMJER IZ PRAKSE: PODUZEĆE „BONUS“ d.o.o. .................................... 20  



Srednja škola Koprivnica                                                        

  

Koprivnica,                                                                 šk.god.2021./2022.                                  18  

Upute za izradbu završnog rada  

  

6.1. Opći podaci o poduzeću .............................................................................. 

20  

6.2. Okolina i konkurencija .................................................................................. 

21 6.3. Odnosi s kupcima i dobavljačima 

................................................................ 21  

6.4. Planiranje i odlučivanje ................................................................................ 

22  

6.5. Računovodstveno planiranje u poduzeću .................................................... 

23  

  

  

7. ZAKLJUČAK ................................................................................................... 25  

  

8. LITERATURA ................................................................................................. 26   

9. POPIS SLIKA ………………………………………………………………………..27  

  

10. POPIS TABLICA …………………………………………………………………..28  

  

9.PRILOZI..............................................................................................................29  

9.1. Bilanca...........................................................................................................

.30  

9.2. Račun dobiti i 

gubitka.....................................................................................31  

9.2. Financijski plan za 2010. godinu....................................................................32  
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Prilog br. 3:  Literatura  

  

5. LITERATURA  
  

Stručne knjige:  

1. Scott, M.; Cutlip Allen H.; Center Glen,  M.: Odnosi s javnošću, Mate d.o.o., 

Zagreb, 2003.  

2. Tkalac Verčić, A.: Odnosi s javnošću, Hrvatska udruga za odnose s javnošću, 

Zagreb, 2015.   

3. Tomić, Z.: Odnosi s javnošću teorija i praksa, Synopsis, Zagreb, 2008.   

  

Internet stranice:  

1. Odnosi s javnošću http://library.fes.de/pdf-files/bueros/sarajevo/06282.pdf  

(4.3.2017.)  

2. Važnost odnosa s javnošću http://ivancolakovic.blogspot.hr/ (4.3.2017.)  

3. web stranice Hrvatske udruge za odnose s javnošću http://www.huoj.hr/osj-

zapocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu (4.3.2017.)  

4. Odnosi s javnošću https://hr.wikipedia.org/wiki/Odnosi_s_javno (20.4.2017.)   

http://library.fes.de/pdf-files/bueros/sarajevo/06282.pdf
http://library.fes.de/pdf-files/bueros/sarajevo/06282.pdf
http://library.fes.de/pdf-files/bueros/sarajevo/06282.pdf
http://library.fes.de/pdf-files/bueros/sarajevo/06282.pdf
http://ivancolakovic.blogspot.hr/
http://ivancolakovic.blogspot.hr/
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
http://www.huoj.hr/osj-za-pocetnike/planiranje-je-najvazniji-dio-odnosa-s-javnoscu-hr528
https://hr.wikipedia.org/wiki/Odnosi_s_javno%C5%A1%C4%87u
https://hr.wikipedia.org/wiki/Odnosi_s_javno%C5%A1%C4%87u
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Prilog br. 4:  Popis slika, tablica i grafičkih prikaza  

6. POPIS SLIKA  
  

1. Slika 1.: Model komunikacijskog kanala  …………………………………………  2  

2. Slika 2.: Korištenje informacije i proces komunikacije u  poslovnoj organizaciji … 3  

3. Slika 3.: Raspodjela bitnih i sporednih dIjelova poslovnog pisma   …………....….  4  

  

7. POPIS TABLICA  
  

1. Tablica 1.: Model komunikacijskog kanala …………………………………………. 3  

2. Tablica 2.: Proces komunikacije u  poslovnoj organizaciji ………………………….. 5  

3. Tablica 3.: Raspodjela bitnih i sporednih dijelova poslovnog pisma   ………...…... 7   
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Prilog br. 5: Posljednja stranica rada  

  

  

Datum predaje rada:___________________________________  
          (mentor je prihvatio izradbu)  
  

Potpis mentora: _______________________________________  

  

  

Ocjena pisanog rada:____________________________________  

  

  

  

  

Datum obrane rada: ____________________________  

  

  

Ocjena obrane rada:____________________________  

  

  

  

Konačna ocjena: ______________________________  

  

  

  

  

Povjerenstvo:   

  

1. mentor: ________________________________  

  

2. profesor struke :__________________________  

  

3. profesor struke:___________________________  

  

  

  

  

  
Prostor za izdvojeno mišljene ili eventualni komentar:  
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Prilog br. 6: Konzultacijski list  

  

  

Konzultacijski list za učenika : ______________________________, razred:______  

  

  

Red. 

br.  

  
Datum  

konzultacija  

Bilješke o napredovanju  Potpis mentora  

  

  

      

  

  

      

  

  

      

  

  

      

  

  

      

  

  

      

  

  

      

  

  

      

  

  

      

  

  

      

  

  

  

  

  

  

  

  

  

   


